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Abstract: 
The thesis takes an insight look into two different models (two-zone and 
three-zone models) for describe the deformation and fracture behaviour 
of the tearing ligament. By earlier works, these two different models 
based on Essential Work of Fracture approach was proved to be capable 
for predicting the specific total work of fracture along the tear path 
across all plastic zones. A comparison of these two models was made 
based on the results from an early experiment. The investigation was 
based on two-leg trousers tear specimen with constant pre-crack length. 
The materials used in this work were PET and a laminate composed of 
PETG/PET. And a finite element simulation will be presented also to 
show the stress around the crack tip and the deformation of the tear 
specimen. The commercial software of ABAQUS will be selected to 
performance the simulation. 
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2 Notation 

A Area                                                                      [
2m ] 

E Young’s modulus                                                 [ MPa ] 

F Force                                                                     [ N ] 

G Shear modulus                                                      [ MPa ] 

K Global stiffness matrix 

ICK  Fracture Toughness                                              [
2/MPa m ] 

IK                  Stress intensity factor                                          [
2/MPa m ] 

l  Ligament Length                                                  [ mm ] 

S Compliance matrix 

t Specimen Thickness                                             [ mm ] 

P Tearing Force                                                        [ N ] 

r Radius                                                                   [ mm ] 

EW  Essential Work of in Plastic Zone                        [J] 

FW                 Total Work of Fracture                                        [J] 

PW                  Non-Essential Work in Plastic Zone                   [J] 

ew                   Specific Essential Work of Fracture                   [
2/J m ] 

fw                   Specific Total Work of Fracture                         [
2/J m ] 
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pw                   Specific Non-Essential Work                             [
2/J m ] 

Tew                  Out-of –Plane Tearing Toughness                      [
2/MPa m ] 

β                    Shape Factor   

σ                    Stress                                                                   [ MPa ] 

ε                    Strain                                                                   

ν                    Poisson’s ratio    
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Abbreviations 

Al-Foil               Aluminium Foil 

ASTM                American Society for Testing and Material 

C                         Centre 

C.T                      Crack Tip 

EWF                    Essential Work of Fracture 

FEM                     Finite Element Method 

LDPE                   Low Density Polyethylene 

Lam                     Laminate 

LEFM                  Linear Elastic Fracture Mechanics 

P.C.T                   Pre-Crack Tip 

OPZ                     Outer Plastic Zone 

MTS                     Mechanical Testing and Simulation 

SI                         Standard International 
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3 Introduction 

3.1 Short presentation  

The Essential Work of Fracture (EWF) Concept has gained increasing 
acceptance and popularity to characterize not only in in-plane (mode I) but 
also in out-of-plane (mode III) fracture toughness of ductile polymer films 
[1]. The basic concept of the EWF Theory is the separation of the total 
fracture energy of a pre-cracked specimen into the geometry dependent 
(non-essential work) and geometry independent (essential work) 
components [2]. In polymer films packaging, out-of-plane (mode III) 
tearing is the most common failure mode. Wong et al [3] and Ho Sung Kim 
[4] proposed two different models in 2003 and 2004 respectively for 
deformation and tearing behaviour of thin polymer sheets under mode III 
loading. Both of these two models are based on EWF Approach for 
prediction of the overall tearing resistance. The detail of EWF Theory will 
be presented in chapter 3.4. 

 

3.2 The aim of the study 

The primary aim of this thesis is to study and compare the two most 
popular models (two-zone and three-zone models) in analyse the tearing 
behaviour of the ductile polymer sheets. Analysis is performed based on a 
series of experiments with a tear-off 2-leg trouser specimen [4]. The 
experiment results obtained from one single layer material (PET-0.5) and a 
laminate (PETG/PET-2.1/18) are selected. Here 0.5, 2.1 and 1.8 is the 
thickness of materials PET, PETG, PET respectively. 

 

3.3 Previous Work 

Resistance to tear is one of the most important mechanical properties of 
flexible materials such as thin polymer sheets, rubbers, etc. The trousers 
test under mode III loading has drawn attention for material evaluation 
since Rivlin and Thomas [5] considered trouser tear criterion for rubbers. 
Green smith and Thomas [6] developed a method to evaluate tear behaviour 
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of rubber vulcanization, involving the determination of energy required for 
tearing and its dependence on the rate of propagation. Sawyers and Rivlin 
[7] studied the development of tear force in both large and small 
deformations. Joe and Kim [8] analysed the load-displacement records to 
determine the critical J-integral value and crack resistance (R) which are 
known as material properties. The determination of the critical J-integral 
value, however, requires the detection of the crack initiation which is not an 
easy task for highly deformable materials. Alternatively, the resistance to 
tear may be evaluated using the essential work of fracture (EWF) approach 
which was first developed for mode I fracture of ductile metals [9]. Several 
works have been performed to study the fracture and mechanical properties 
of thin materials used in food packaging and can be found in [10, 11] and 
also many studies have described the tearing behaviour of flexible materials 
[12, 13]. 
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4 Prerequisite Theory of Fracture 

Fracture mechanics [14] is the field of solid mechanics that deals with the 
behaviour of cracked bodies subjected to stresses and strains. These can 
arise from primary applied loads or secondary self-equilibrating stress 
fields (e.g. residual stresses). The power of fracture mechanics really lies in 
the fact that local crack tip phenomena can, to a first order, be characterized 
by relatively easily measured global parameters, e.g. crack length and 
nominal global stress (calculated in the absence of the crack), together with 
finite geometry correction factors. Use of fracture mechanics in engineering 
critical assessment of defects has been codified in documents like British 
Standards PD 6493 : 1991 (Guidance on Methods for Assessing the 
Acceptability of Flaws in Fusion Welded Structures - currently under 
revision as BS 7910 - Guide on Methods of Assessing the Acceptability of 
Flaws in Structures) and the CEGB R6 procedure (Assessment of the 
Integrity of Structures Containing Defects).    

 
4.1 Three Modes in Fracture Mechanics 

Stress and deformations in the materials in front of a crack tip depend on 
how the cracked structure is loaded. A crack may be loaded in three 
different ways, and named Mode I, Mode II, Mode III [14] respectively: 

–   In Mode I (Open Mode): the crack is opened so that the crack surfaces 
are separated from each other, see figure 3.1(a); 

– In Mode II (In-Plane Mode) : the crack is sheared in the plane of the 
crack so that the crack surfaces move relative to each other in shear in 
the x-direction, see figure 3.1(b); 

– In Mode III (Out-of-Plane Mode): the crack is sheared in the plane of 
the crack so that the crack surfaces move relative to each other in shear 
in the z-direction, see figure 3.1(c). 
 

In Mode I and II all displacements occur in the XY-plane, however, the 
displacements in Mode III occur in the z-direction. A general loading can 
always be expressed as a combination of Mode I, II, and III loading of the 
crack. 
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Figure 3.1 (a) Crack loaded in Mode I. Crack is opened  

 

 
Figure 3.1 (b) Crack loaded in Mode II. Crack is sheared in the XY-plane 
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Figure3.1 (c) Crack loaded in Mode III. Crack is sheared out of the XY-plane 

 

In fact, more than one of above modes can exist together, which is called 
mixed mode [15].  

 

4.2 Stresses and deformations at a crack tip 

Let’s use xxσ , yyσ , xyτ , yzτ  express the stress components, and xu , yu , zu  are 
displacement components[14]. 

Mode I  
Mode I loading of a crack is characterized by symmetry with respect to the 
x-axis, for example ( , ) ( , )y yu x y u x y= − − , see the figure 3.2 
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Figure 3.2Stress and deformations under Mode I 

The displacements yu  of the crack surfaces (upper and lower surfaces) 
close to the crack tip are  

1 2 ( 0)
4y I

xu K xκ
μ π
+ −

= ± <  

Where  

3 4κ ν= −            At plane strain 

3
1

νκ
ν
−

=
+

            At plane stress 

And  

2(1 )
Eμ
ν

=
+

 ,         

Here ν  is the Poisson ratio of materials. 

The dominating stress components at the crack tip lie in the x and y 
directions and are 

( 0)
2

I
xx yy

K x
x

σ σ
π

= = >  

Mode II 
Mode II loading of a crack is characterized by anti-symmetry with respect 
to the x-axis, for example ( , ) ( , )x xu x y u x y= − − , see figure 3.3. 
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Figure 3.3 Stress and deformations under Mode II 

The displacement of the crack surfaces (upper and lower surface) close to 
the crack tip are 

 1 2 ( 0)
4x II

xu K xκ
μ π
+ −

= ± <  

(κ  and μ  as same as in Mode I) 

The dominating stress component at the crack tip lies in the x-direction and 
is  

( ) ( 0)
2

II
xy yx

K x
x

τ τ
π

= = >  

Mode III 
Mode III loading a crack is characterized by anti-plane symmetry with 
respect to the XZ-plane, for example ( , ) ( , )z zu x y u x y= − − , see the figure 
3.4. 

 
Figure 3.4 Stress and deformations under Mode III 
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The displacement of the crack surfaces (upper and lower surface) close to 
the crack tip are 

2 ( 0)III
z

K xu x
μ π

−
= ± <  

μ  is the same as in Mode I. 

The dominating stress component at the crack tip lies in the z-direction and 
is  

( 0)
2

III
yz

K x
x

τ
π

= >  

The factor IK , IIK and IIIK give a measure of strength of the stress 
singularities at the crack tips. These factors are called the stress intensity 
factor, and they play an important role in fracture mechanics analysis. 
These factors can be expressed in the form: 

, ,I y II yx III yzK a f K ag and K ahσ π σ π σ π∞ ∞ ∞= = =  

Here ‘a’ is the crack length; the factors f, g and h are functions of geometry 
(for example the crack length) and the type of loading. The stresses marked 
with an index ∞ are the remote stresses ‘far away’ from the crack. These 
stresses are induced by the loading of the structure. The remote stresses 
caused the very high stresses at the crack tip (compare the remote stress 
with the ‘nominal stress’ in the case of stress concentration).  

4.3 Fracture toughness 

Resistance fracture of a loaded material is defined as fracture toughness. 
Fracture toughness usually depends on the constraints of the materials 
(highly depends on thickness when thin materials are under consideration) 
along with its microstructure, loading rate, environment and temperature 
[1].  

4.4 Crack Propagation  

A crack will propagate in a loaded specimen when its stress intensity factor 
reaches a critical value; this critical value of KI is called fracture toughness. 
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Analyzing the crack propagation in energy terms, it is found that material 
uses the stored strain energy to produce new surfaces. The material has to 
have enough strain energy to create new surfaces; otherwise crack growth 
will be stopped. In mathematical terms this idea can be presented as: 

G=R 

Where G is the desired energy to create crack and R is the resistance of the 
material to the crack growth. 

For the crack to continue growing, the change in energy must be equal to 
change in resistance. If the change in energy is less than change in 
resistance then crack will not grow anymore unless more force is applied. If 
the change in energy is more than in resistance the crack will follow 
unstable growth and may continue growing until the failure of the structure 
[14]. 

4.5  EWF Theory 

In the Essential Work of Fracture (EWF) Theory, there is a distinction 
between a process zone (process plane) where the actual crack runs and a 
plastic zone, which surrounds the process zone. Consequently, the total 
work required to fracture a pre-cracked specimen can be divided into two 
parts associated with each of the two zones mentioned as above: the 
essential work of the fracture ( EW ), and the non-essential or plastic work of 
the fracture ( PW ), respectively.  

Here EW  is the energy for yielding and tearing of the inner fracture process 
zone, which is called the essential work; PW  is called non-essential work 
which is the work done in yielding of the outer plastic zone and the actual 
energy dissipated in the outer plastic region where various types of the 
deformations may take place. Therefore, EW  is surface related, whereas PW  
is a function of the deformed plastic zone volume. The latter depends on the 
deformation mechanisms (affecting the shape of the plastic zone), which is 
strongly influenced by testing conditions. 

The total work of fracture ( FW ) for a pre-cracked sample, in the double-
edge-notched tension (DENT) geometry, under mode I loading can be 
divided into two components: 

F E PW W W= +                                (3.1) 
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As described before, EW  is the work spent for the crack advance in the 
process plane (generation of new surfaces) and PW  is the energy consumed 
in the outer plastic zone. Thus, EW  is related to a 2-D plane and is therefore 
a function of area ( lt ), whereas PW  is dissipated in a 3-D plastic zone and 
thus can be considered a function of volume ( 2l t ).  

Equation (3.1) can be now rewritten as following, 
2

F e pW w lt w l tβ= +                               (3.2) 

The total specific work of fracture is given by, 

F
f

Ww
lt

=                                               (3.3) 

From equation (3.2) and (3.3) 

f e pw w w lβ= + (3.4) 

Here ew is the specific essential work of fracture and pw  is the specific 
non-essential fracture work. β  Is the shape factor for the outer plastic zone 
(OPZ), and t  is the specimen thickness.  

According to equation (3.4), the work of fracture is a linear function of the 
ligament size. We can determine ew  from the interception of the linear 
regression line, fitted to fw  vs. l  graphs, with the y-axis plot shown in 
figure 3.2. It should be mentioned that FW  can be determined by 
calculating the integral of the force over displacement from the tensile tests 
performed on DENT specimens of various ligament sizes. An important 
prerequisite of the plane stress EWF approach is that the crack propagates 
only after the ligament has been fully yielded. 
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Figure 3.5(a) Schematic drawing showing the inner fracture process zone and the outer plastic zone 
for a DENT specimen. (b) Plot showing the linear relationship between the specific total fracture 
work fw and torn ligament l .The specific essential fracture work can be obtained from the fw -

intercept. [15] 
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5 Analysis Models for Tearing  

5.1 Short Introduction of Two models 

The trousers test under out-of–plane (mode III) loading has drawn attention 
for material evaluation. In the present study, the EWF technique has been 
great developed for the characterization of mode III tearing fracture of 
some ductile films.  

Two kinds of models are very popular which were proposed for describe 
the deformation and tearing behaviour of ductile polymer sheets. One is the 
two-zone model which was proposed by Wong et al [3] 2003. In two-zone 
model, the first zone is called zone A and is adjoining the initial crack tip, 
the outer plastic zone height increases with crack length (or torn 
ligament l ). At the end of zone A, the height of the plastic zone has 
saturated, and the deformation has entered zone B. The height of the outer 
plastic zone remains constant with further increase of torn ligament length. 
The two-zone model is shown as following figure 4.1. 

 
Figure 4.1 Two-zone model under mode III tearing test [3]  

The other model for mode III loading is three-zone model [4] that was 
proposed by Ho Sung Kim and Jozsef Karger-Kocsis in 2004. A three-zone 
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model is consisted of initial, evolutionary and established plastic zones for 
tearing resistance. In the three zone model, the outer plastic zone is 
assumed has three distinctive zones as detailed shown in the following 
figure 4.2. The three zones will be defined as:  

Zone I, the initial zone, is formed as loading increases prior to the crack 
propagation;  

Zone V, got name because of its V-shape;  

Zone S, where the plastic deformation is established and thus the height h 
of plastic zone becomes constant. 

 

 
Figure 4.2 Three-zone model for mode III tearing test [4] 
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5.2 The Description of Two Experimental Results 
Chosen From [4]  

In [4], a serial of experiments have been performed for different materials 
and their combination. Two of them with the materials: PET-
0.5,PETG/PET-2.1/18 will be chosen in this study. Comparison will be 
made by applying two-zone model and three-zone model respectively.  

As schematically indicated for a specimen with sufficiently long ligament 
in figure 4.1 and 4.2 (if the ligament length is not long enough, then only 
partial deformation occurs). Generally two different types of deformation 
appeared along the torn ligament after tearing. One is plastic deformation 
and the other did not cause any visible change in the surface texture of the 
specimens. Compared to the plastic zone, its deformation energy would be 
small. Therefore, it will not be included in the present model analysis. 

Figure 4.3 (a) and (b) are the Load-displacement figures of these two 
materials that have been redrawn from the experiment done by Ho Sung 
Kim [4]. All specimens were cut from the sheets and their longitudinal 
direction was parallel with the extrusion directions to ensure that any 
effects of orientation are eliminated. 
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PETG/PET-2.1/18
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Figure 4.3 Load versus displacement curves from trousers tear testing for the mono- and bi-layer 

sheets: PET-0.5;PETG/PET-2.1/18 [4] 

The total area under the tearing load-displacement curves, which represents 
the total fracture work, was used to evaluate the total specific fracture work 
for specimen. 

Some important parameters of materials are given in Table 4.1. 
Table4.1 Materials used and their basic properties: 

Materials (composition ratio)     Thickness(mm)          Tensile strength (MPa)               E-modulus(GPa) 

Mono-layer  

PET(Eastapak® 9921)                0.508                           58.70                                          1.97 

Bi-layer 

PETG/PET(2.1/18)                     0.508                           55.92                                          1.96 

Note thickness (in mm) for bi-layer is given in parenthesis. 

 

5.2.1 Recalculate the essential work using three-zone model 

According to the above-mentioned introduction of three-zone model, the 
plastic zone is assumed to have three distinctive zones as detailed shown in 
the following figure 4.4. The three zones are defined as:  

Zone I, initial zone, is formed as loading increases prior to the crack 
propagation;  

Zone V, got name because of its V-shape;  
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Zone S, where the plastic deformation is established and thus the height 
becomes constant. 

 
Figure 4.4 Plastic zone model consisting of zones I, V, S for tear specimens with sufficiently long 
ligaments [4] 

Again, according to the EWF theory, the total work of fracture for a pre-
cracked test specimen can be divided into two parts, 

f e pW W W= +                                                                                   (4.1) 

For the initial zone, zone I, is in the range of 0 i il L< <  : 

The total work of fracture for the specimen with a ligament length il  is 
given, 

if ie ip ie i ip iW W W w l t w At= + = +                                                          (4.2) 

Where the subscript ‘i’ means the zone I, iew  is the specific essential work 
of fracture, ipw  is the specific non-essential work of fracture, t  is the 
thickness of the specimen and, iA  is the area of outer plastic deformation 
zone. Equation 4.3 considers the fact that the profile of the initial plastic 
zone is inclined approximately 45 degrees to the tear path, and this 
assumption appears reasonable from the polarized light microscopic 
images. Fig 4.5 [4] iA  is given as following, 

21
2i i iA hl l= =                                                                                   (4.3) 

Thus, 
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2
if ie ip ie i ip i

if
if ie ip i

i

W W W w l t w l t

W
w w w l

l t

= + = +

= = +
                                                  (4.4) 

And ifw  is the specific total work of fracture.  In practice, it is difficult to 
use equation (4.4) to determine iew , because il  is too small to be varied in 
testing specimens. 

For zone V, 0 v vl L< < ,  

The total work of fracture vfW  is 

( )vf ve vp ve i v vp vW W W w L l t w A t= + = + +                                     (4.5) 

Where, the subscript ‘v’ means the zone V. Here we suppose the taper 
angle of zone V isα , so the area vA  is obtained by: 

2 2 2(2 2 2 ) 2
2

i v i v
v i i i v v

L l L lA L L L l lα α+ +
= + = + +                    (4.6) 

Where the angle 2
2

s i

v

h L
L

α −
= , 

Where sh  and iL  can be directly measured from the specimens in the 
testing, and vL  can be evaluated from the plot of specific total work of 
fracture versus ligament length of specimens if it is difficult to be identified 
under the microscope. 

Then the total work of fracture in this case is  
2 2( ) ( 2 )vf ve i v vp i i v vW w L l t w L L l l tα= + + + +  

The specific total work of fracture becomes  
2 2( 2 )

( )
vf vp i i v v

vf ve
i v i v

W w L L l l
w w

L l t L l
α+ +

= = +
+ +

                             (4.7) 

Where vpw  and vew  can be found from linear regression analysis using a 
plot of vfw  which are known as the experimental results 
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versus 2 2( 2 ) / ( )i i v v i vL L l l L lα+ + + . Specially, in the case of il L=  and 
0vl =  

Equation (4.7) becomes  

vf ve vp iw w w L= +                                                                          (4.8) 

 

(a)  
 

(b)  
Figure 4.5 [4] Polarized light microscopic images for plastic deformation near the crack tip for two 

different specimens showing zones I and V: (a) PET-0.5; (b) PETG/PET-2.1/18. The direction of 
crack propagation is from right side to the left. 

For the zone S, when 0 s sl L< < : 

The total work of fracture  
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( )sf se sp se i v s sp sW W W w L L l t w A t= + = + + +  

Where the 2 22s i i v v s sA L L L L h lα= + + +  

So,  
2 22

( )
sf i i v v s s

sf se sp
i v s i v s

W L L L L h lw w w
L L l t L L l

α+ + +
= = +

+ + + +
         (4.9) 

Where spw  and vew  can be found by linear regression analysis using 
experimental data from specimens with ligament length longer than 
( )i vL L+  for a plot of sfw  versus 2 2( 2 ) / ( )i i v v s s i i sL L L L h l L L lα+ + + + + , but 
preferably the data can be combined with those for vfw  and 

2 2( 2 ) / ( )i i v v i vL L l l L lα+ + +  in equation (4.7) for a full range of data 
analysis since e ve sew w w= = , and p vp spw w w= = . 

With these equations, a series of measuring and calculate were performed 
in order to redraw the curve of specific total essential work along the 
ligament’s length. 

Firstly, the ligament of specimen can be found from the load-displacement 
curves. In figure 4.3, the first digressive point in the graph is the beginning 
where the crack starts to grow. The ligament length value can be now 
evaluated as: the displacement value of the last point minus the 
displacement value of the first digressive point and divided by two. 

The results of PET-0.5 and PETG/PET-2.1/18 are given in following tables 
and figures. 
Table 4.2 Specific total work of fracture as a function of torn ligament length: 

(a) PET-0.5 

Ligament length(mm) Total work of fracture(J)  Specific total work of fracture( 2/J m ) 

3.5 

6   

8 

11.5 

14 

19.5 

25.5    

111.3386311   

266.996637   

442.068662 

623.010858     

761.9985871 

1174.888682 

1826.49306   

63.62207491 

88.998879 

110.5171655 

108.3497144 

108.856941 

120.5014033 

143.2543576 
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30  

40    

48.5 

58.5 

60 

2285.02832 

2899.901   

3710.25919 

4484.12982 

4649.8614 

152.3352213 

144.99505 

153.000379 

153.3035836 

154.99538 

 

(b) PETG/PET-2.1/18 

Ligament length(mm) Total work of fracture(J)  Specific total work of fracture( 2/J m ) 

3 

6.5 

10 

12 

13.5 

18.5 

22 

31.5 

40 

50 

60 

108.89 

300.65 

545.744 

673.73 

927.41 

1342.88 

1487.97 

2540.96 

2771.24 

3701.034 

4424.477 

71.45 

91.05 

107.43 

110.52 

135.23 

142.89 

133.14 

158.79 

136.38 

145.71 

145.16 
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(a) 

(b) 

Figure 4.6 Specific total work of fracture as a function of ligament length got from both experiments 
and based on Equations (4.4). (4.7) and (4.9) 
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Table 4.3 [4] 

Input values measured/estimated for regression analysis and resulting tear parameter values 

Materials                          

(composition ratio) 

 Li(mm)            

 

 hs(mm)                          

          

Lv(mm)              α  

Mono-layer  

PET(Eastapak® 9921) 

 

Bi-layer 

PETG/PET(2.1/18)                   

 

0.89 

 

 

0.96 

 

3.57 

 

 

3.89 

 

31                    0.058 

 

 

21                    0.094 

The input values of material PET-0.5 and PETG/PET-2.1/18 from [4] were 
given in table 4.3. 

Further more, to get the curves of the specific total work of fracture 
versus *L , can be redrawn. As described in [4], the *L  is  

2 2( 2 ) / ( )i i v v i vL L l l L lα+ + +  or 2 2( 2 ) / ( )i i v v s s i v sL L L L h l L L lα+ + + + +  

When 3.5i i vL l mm L L< = < + , 
* 2 2

2 2

( 2 ) / ( )

0 .89 2 0.89 2.61 0.058 2.61 1.667
3.5

i i v v i vL L L l l L l

m m

α= + + + =

+ × × + ×
=

 

Thus, the relation between the specific total work of fracture of PET-0.5 
versus *L  (a) and the specific total work of fracture of PETG/PET versus 

*L  (b) are shown in Figure 4.7 below. 
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(a)  

(b) 

Figure 4.7 Linear plot for two different specimens between the specific total work of fracture and
*L : 

(a) PET-0.5; (b) PETG/PET-2.1/18 
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5.2.2 Recalculation of the essential work using two-zone model 

 

 

 

 

 

 

 

 

 

 
Figure 4.8 Plastic zone models consisting of zones A, B for tear specimens with sufficiently long 
ligaments 

In zone A, the height of the plastic zone (h) increases with crack length, i.e. 
h increases as the initial crack front moves along its path. The total fracture 
work in this zone is therefore given by: 

F E P e a p aW W W w l t w A t= + = +                                                   (4.10) 

al  Represents the torn ligament in zone A, that is 0 a Al l< ≤ and aA is outer 
plastic zone area in zone A. If the outer plastic zone height h is 
approximately by: 

'2 ah lα≈                                                                                    (4.11) 

And here  

'

2
s

a

h
L

α =                                                                                    (4.12) 

aA  Can be written as: 

' 2 ' 21 2
2a a aA l lα α= =                                                      (4.13)  

By substituting Eq. (4.13) into Eq. (4.10), we have: 

bl  

al

Al  Bl  

l

Zone A Zone B 

hs 
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' 2
AF Ae a Ap aW w l t w l tα= + ⇒    '

Af Ae Ap aw w w lα= +                       (4.14) 

It can be seen from the equation (4.14) that if the torn ligament length al in 
the trousers specimen is less than Al , the specific essential fracture work 

Aew  can be determined from the y-axis intercept of Afw versus al  plot. 

In the zone B model the height of plastic zone has already saturated. We 
expect that of the essential work of fracture can be extracted from the total 
tearing work measurements. It should be identical to the essential work of 
fracture obtained in zone A. Thus, in zone B, the total tearing fracture work 
is ： 

)

) ( )
2

BF BE BP Be a b Bp B

s a
Be a b Bp s b

W W W w L l t w A t

h Lw L l t w h l t

= + = + + =

+ + +

（

（
                           (4.15) 

Where Bl  is the length of zone B ligament and 
2

s a
B s b

h LA h l= +  is the area 

of the plastic zone in zone B, so we have: 

 2
2( )
s a s b

Bf Be Bp
a b

h L h lw w w
L l
+

= +
+

                                                    (4.16) 

Thus, if we can prepare 2-leg trousers with different constrained plastic 
zone height sh , the specific tearing work of Bew can be obtained from a plot 

of Bfw against 2
2( )
s a s b

a b

h L h l
L l
+
+

according to Eq. (4.16). 

Since the total work of fracture is the total area under the Load vs. 
Displacement curves which was given in Figure 4.3 [4]. It is obvious that 
both three-zone and two-zone model have the same result with the curves 
of Specific total work of fracture versus ligament length. 

The results of using two-zone model and from experiments are shown in 
the figure 4.9. 
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(a) 

 
(b) 

Figure 4.9 Specific total work of fracture as a function of ligament length got from both experiments 
and based on Equations (4.14) and (4.16) 



 34

The input values [10] measured /estimated for regression analysis and 
resulting tear parameters values were given as: 
Table 4.4 

Materials                          

(composition ratio) 

 La(mm)            

 

 hs(mm)                   

          
            'α  

Mono-layer  

PET(Eastapak® 9921) 

 

Bi-layer 

PETG/PET(2.1/18)                   

 

31.89 

 

 

21.96 

 

3.57 

 

 

3.89 

          

           0.056 

            

            

0.089 

In order to make a comparison to the three-zone model, a parameter of #L  
have to be defined as: 

#L = '
alα                                                          when 0 al L< <  

Or #L = ( 2 ) / 2 ( )s a s b a bh L h l L l+ +       when a a bL l L L< < +  
Similar to the case of three-zone model, when 0 3.5 al mm L< = < , 

# ' 0.056 3.5 0.2aL l mmα= = × ≈  

Thus, the relation between the specific total work of fracture of PET-0.5 
versus #L  (a) and the specific work of fracture of PETG/PET-2.1/18 versus 

#L  (b) are shown in Figure 4.10 below.  
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(a) 

(b) 
Figure 4.10Linear plots with least square lines for data shown in Figure 4.9. (a)PET-

0.5 ;( b)PET/PETG-2.1/18 
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5.3 Results and Comparison 

In this part, the method of calculating mean value of relative error 

expressed as 
*

*

1
/

N
n n

r
n n

x x
e N

x=

⎛ ⎞−
⎜ ⎟=
⎜ ⎟
⎝ ⎠
∑  will be chosen to evaluate the results 

from those two different models. Here *x  is the evaluation got by using 
models; x is the experimental result. 

5.3.1 Three-zone model results 

The final results got by using three-zone model are given in the appendix A. 

Table 4.5 Specific total work of fracture versus *L : 

(a)PET-0.5 

Ligament length(mm) *L (mm)  Specific total work of fracture( 2/J m ) 

3.5 

6   

8 

11.5 

14 

19.5 

25.5    

30  

40    

48.5 

58.5 

60 

1.667 

1.9    

2.05 

2.28 

2.435 

2.77 

3.13 

3.39 

3.517   

3.526 

3.533 

3.534 

63.62207491 

88.998879 

110.5171655 

108.3497144 

108.856941 

120.5014033 

143.2543576 

152.3352213 

144.99505 

153.000379 

153.3035836 

154.99538 

The relative error of evaluated results using three-zone model for PET-0.5 
is: 

* 4.37%re ≈  

 (b)PETG/PET-2.1/18 

Ligament length(mm)  *L (mm)  Specific total work of fracture( 2/J m ) 

3  1.743  71.45 
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6.5 

10 

12 

13.5 

18.5 

22 

31.5 

40 

50 

60 

2.22 

2.6 

2.798 

2.98 

3.43 

3.77 

3.8 

3.82 

3.84 

3.845 

91.05 

107.43 

110.52 

135.23 

142.89 

133.14 

158.79 

136.38 

145.71 

145.16 

The relative error of evaluated results using three-zone model for 
PET/PETG-2.1/18 is: 

* 5.5%re ≈  

5.3.2 Two-zone model results 

Final results got by using two-zone model are shown in the Appendix A. 

Table 4.6 Specific total work of fracture versus #L : 

(a)PET-0.5 

Ligament length(mm)  #L (mm)  Specific total work of fracture( 2/J m ) 

3.5 

6 

8 

11.5 

14 
19.5 
25.5 
30 
40 
48.5 
58.5 
60 

0.2 

0.35 

0.464 

0.667 

0.812 

1.131 

1.48 

1.74 

2.15 

2.4 

2.6 

2.62 

63.62207491 

88.998879 

110.5171655 

108.3497144 

108.856941 

120.5014033 

143.2543576 

152.3352213 

144.99505 

153.000379 

153.3035836 

154.99538 

The relative error of evaluated results using two-zone model for PET-0.5 is: 
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* 8.45%re ≈  

(b)PET/PETG-2.1/18 

Ligament length(mm)  #L (mm)  Specific total work of fracture( 2/J m ) 

3 

6.5 

10 

12 

13.5 

18.5 

22 

31.5 

40 

50 

60 

0.27 

0.58 

0.89 

1.0632 

1.2 

1.64 

1.95 

2.534 

2.82 

3.04 

3.18 

71.45 

91.05 

107.43 

110.52 

135.23 

142.89 

133.14 

158.79 

136.38 

145.71 

145.16 

The relative error of evaluated results using two-zone model for 
PET/PETG-2.1/18 is: 

* 9.62%re ≈  

  

5.3.3 Comparison 

The curves of  specific total work of fracture versus specimen ligament 
length got by using three-zone model, two-zone model and experimental 
data are plotted in the firgures 4.6, 4.7, 4.9 and 4.10.  

For figure 4.6, the predictions made by using three-zone model appeared to 
be a good agreement with the experimental results. And the results for  
mono-layer materials PET-0.5 is better than the bi-layer material 
PET/PETG-2.1/18. Acooring to the EWF theory, there is a linear 
relationship between the specific total work of fracture  and the L*, plot 4.7 
shows the linear plots with least square method by using 3-zone model.   

For figure 4.9, the predictions got by using two-zone model and copmared 
with the experiments supports that two-zone model are also valid for 
evaluate the tearing resistance but with a lower accuracy. Figure 4.10 
shows that also a worse linear plots than three-zone model. As same as 
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using three-zone model , the results of layer material PET-0.5 is much 
better than bi-layer material PET/PETG-2.1/18. 

To present the difference exactly, the relative error of both three-zone 
model and two-zone model are calculated for two kinds of materials. For 
mono-mayer material PET-0.5, the realtive error of using three-zone model 
is 4.37% and the value by using two-zone model is 8.45%; for bi-layer 
material PET/PETG-2.1/18 the relative error got by using three-zone model 
is 5.5% and is 9.62% by using two-zone model. These values supports the 
conclusions got above in the mathematic way. 
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6 Simulation in ABAQUS 

6.1 Simple Introduction of ABAQUS 

ABAQUS is a suite of powerful engineering simulation programs, based on 
the finite element method, which can solve problems ranging from 
relatively simple linear analysis to the most challenging nonlinear 
simulations. ABAQUS contains an extensive list library of elements that 
can model virtually any geometry. It has an equally extensive list of 
material models that can simulate the behaviour of most typical engineering 
materials including metals, rubbers, polymers, composites, reinforced 
concrete, crushable and resilient foams, and geotechnical materials such as 
soils and rock. Designed as a general-purpose simulation tool, ABAQUS 
can be used study more than just structural (stress/displacement) problems. 
It can simulate problems in such diverse areas as heat transfer, mass 
diffusion, thermal management of electrical components (coupled thermal-
electrical analyses), acoustics, soil mechanics (coupled pore fluid-stress 
analyses), and piezoelectric analysis. 

 

ABAQUS offers a wide range of capabilities for simulation of linear and 
nonlinear applications. Problems with multiple components are modelled 
by associating the geometry defining each component with the appropriate 
material models and specifying component interactions. In a nonlinear 
analysis ABAQUS automatically chooses appropriate load increments and 
convergence tolerance and continually adjusts them during the analysis to 
ensure that an accurate solution is obtained efficiently.  

6.2 ABAQUS /CAE Model 

The procedures of how to create the tearing specimen model in ABAQUS 
please find in Appendix C. 

6.3 Simulation Results 

6.3.1 Stresses around the crack tip 

No crack initiation is considered. The material PET is used for the 
ABAQUS simulation. 
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Table 5.1The stresses’ range around the crack tip 

Materials                         S11(MPa)             S22(MPa)                     S12(MPa) 

                                 Elastic 

PET-0.5    Elastic-plastic 

                                 

PETG/PET               Elastic 

                    Elastic-plastic 

0.96~1.37 

 4.33~7.16 

 

15~70 

12~41 

0.32~0.49 

23.14~37.33 

 

15~30 

1~9 

       0.46~0.67 

       25.21~31.12 

        

       23~55 

       22~24 

S11, S22 and S33 are the normal stresses in three planes whereas S12 is the 
shear stress from plane 1 to plane 2. The normal stresses S33 are 0 in all the 
cases. 

It can be seen that the stress components around the crack tip are more 
when plastic is under considered. 

The stress distribution in the whole model is shown in Appendix D.  

6.3.2 Shear stress S12 comparison 

For the tearing resistance simulation, the Shear stress S12 is the most 
important stress component. So the distribution of shear stress along the 
crack path is drawn for both two materials. The plots will be made between 
the shear stress values and x-direction named the direction of crack 
propagation. Then the data were plotted in excel too and shown in the 
following figures. 
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Figure 5.1Shear stress S12 for mono-layer PET along the crack path (Elastic) 

 
Figure 5.2Shear stress S12 for mono-layer PET along the crack path (Elastic-Plastic) 



 43

 
Figure 5.3Shear stress S12 for bi-layer PET/PETG along the crack path (Elastic) 

 

 
Figure 5.4Shear stress S12 for bi-layer PET/PETG along the crack path (Elastic-Plastic) 
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The results shows that when only consider the materials be elastic, along 
the crack path, the shear stress is decreased, and it means that the shear 
stress is bigger with closer to the crack tip. When plastic is also under 
considered for materials the shear stress along the direction of crack 
propagation, the first stage the stress S12 is increasing and then start to 
decreasing which means that the biggest shear stress isn’t at the crack tip 
but very close to it. In this case the biggest shear stress is occurred around 
6mm to the crack tip. 
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7 Conclusion 

1.  Both two-zone and three-zone model based on EWF approach for 
tearing behaviour have been demonstrated to be capable of predicting 
for thin polymer sheets. 

2. The two-zone model hence would lead to overestimation of EWF if 
tearing is the case. 

3. Three-zone model has a higher accuracy than two-zone model. Both 
two-zone and three-zone models are more suitable and with a higher 
accuracy for mono-layer polymer sheets compared to the laminates. 

4. The Finite element calculation result shows that: for mono-layer material 
PET-0.5, the maximum shear stress will be higher when plasticity was 
considered. However, for laminate material PET/PETG, the maximum 
shear stress in PET will be lower when plasticity was considered.  
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Appendix A- Evaluation Results  

A.1Results of 3-zone Model 

Specific total work of fracture versus *L : 

 
(a) PET-0.5 

 

Ligament length(mm) *L (mm)  Specific total work of fracture( 2/J m ) 

3.5 

6   

8 

11.5 

14 

19.5 

25.5    

30  

40    

48.5 

58.5 

60 

1.667 

1.9    

2.05 

2.28 

2.435 

2.77 

3.13 

3.39 

3.517   

3.526 

3.533 

3.534 

63.62207491 

88.998879 

110.5171655 

108.3497144 

108.856941 

120.5014033 

143.2543576 

152.3352213 

144.99505 

153.000379 

153.3035836 

154.99538 

The relative error of evaluated results using 3-zone model for PET-0.5 is: 
* 4.37%re ≈  

 
(a) PETG/PET-2.1/18 

 

Ligament length(mm)  *L (mm)  Specific total work of fracture( 2/J m ) 

3 

6.5 

10 

12 

1.743 

2.22 

2.6 

2.798 

71.45 

91.05 

107.43 

110.52 
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13.5 

18.5 

22 

31.5 

40 

50 

60 

2.98 

3.43 

3.77 

3.8 

3.82 

3.84 

3.845 

135.23 

142.89 

133.14 

158.79 

136.38 

145.71 

145.16 

 

The relative error of evaluated results using 3-zone model for PET/PETG-
2.1/18 is: 

* 5.5%re ≈  
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A.2Results of 2-zone Model 

Specific total work of fracture versus #L : 

 
(a) PET-0.5 

 

Ligament length(mm)  #L (mm)  Specific total work of fracture( 2/J m ) 

3.5 

6 

8 

11.5 

14 
19.5 
25.5 
30 
40 
48.5 
58.5 
60 

0.2 

0.35 

0.464 

0.667 

0.812 

1.131 

1.48 

1.74 

2.15 

2.4 

2.6 

2.62 

63.62207491 

88.998879 

110.5171655 

108.3497144 

108.856941 

120.5014033 

143.2543576 

152.3352213 

144.99505 

153.000379 

153.3035836 

154.99538 

 

The relative error of evaluated results using 2-zone model for PET-0.5 is: 
* 8.45%re ≈  
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(b) PET/PETG-2.1/18 

 

Ligament length(mm)  #L (mm)  Specific total work of fracture( 2/J m ) 

3 

6.5 

10 

12 

13.5 

18.5 

22 

31.5 

40 

50 

60 

0.27 

0.58 

0.89 

1.0632 

1.2 

1.64 

1.95 

2.534 

2.82 

3.04 

3.18 

71.45 

91.05 

107.43 

110.52 

135.23 

142.89 

133.14 

158.79 

136.38 

145.71 

145.16 

 

The relative error of evaluated results using 2-zone model for PET/PETG-
2.1/18 is: 

* 9.62%re ≈  
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Appendix B-ABAQUS/CAE Model 

B.1Assumptions 

Some assumptions were made as: 

1. All materials are assumed to be isotropic; 

2. All materials’ Poisson’s ratio is assumed to be 0.3 always; 

3. All the materials are assumed to be homogeneous。 

 

B.2Pre-Processing 

In this part the model of the specimen was generated and an input file of the 
model was saved. 

Steps followed at this stage as follows: 

◇ Part   

Create and modify a base feature for a deformable shell part : 
1. Start ABAQUS/CAE by entering the following command at the 

prompt: ABAQUS/CAE. 
2. Select Create Model Database from the Start Session dialog box. 
3. ABAQUS/CAE automatically loads the Part module. 
From the main menu bar, select Part → Create to create the new part. 
The text in the prompt area asks you to fill out the Create Part dialog 
box. 

ABAQUS/CAE always displays prompts in the prompt area to guide you 
through a procedure. 

4. Name the part half_1; and ensure that the selections for Modeling 
Space 3D, Type Deformable , and Base Feature are Shell ; 

5. Enter 200 as the approximate size of the model. The units used for 
the parts are millimeters. ABAQUS/CAE does not have any built-
in units. It is the user's responsibility to choose a consistent set of 
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units. The approximate size chosen should be sufficient so that any 
aspect of the part can be modeled. 

6. Click Continue. 
ABAQUS/CAE initializes the Sketcher and displays a grid.  

7. Select the Create Lines: Connected tool from the Sketcher toolbox. 
8. Locate the cursor at the point with the coordinates (0, 0), and click 

mouse button 1. Move the cursor to (0, 25), and click mouse button 
1 again.  

9. Click mouse button 2 in the viewport to exit the Create Lines: 
Connected tool.  

10. Select the Create Lines: Connected tool again from the Sketcher 
toolbox. 

11. Locate the cursor at the point with the coordinates (0, 0), and click 
mouse button 1. Move the cursor to (0, -25), and click mouse 
button 1 again.  

12. Exit the Create Lines: Connected tool by click mouse button 2.  
13. Select Create Circle: Center and Perimeter to draw a circle with 

diameter 8mm as the filleted. 
14. Click done in the prompt area to complete the sketch. 
15. In the Edit Base Extrusion dialog box, enter an extrusion depth of 

12.5and click OK. 
16. ABAQUS/CAE exits the Sketcher and displays the extruded part as 

a shaded plot in the viewport. Use the Render Model tools located 
in the main tool bar to change the render style. 

17. Copy half_1 to create other half named half_2. 

◇ Property 

Creating a material: The shell parts are assumed to deform elastically and to 
possess the properties of PET. Create a material named PET with a Young's 
modulus of 1，970 MPa and the Poisson's ratio is 0.3.  
 
Table B.1Mechanical properties of the materials  
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Materials  Young’s 
modulus 

[MPa] 

Strain   Possion’s 
Ratio 

Tensile 
Stress[MPa] 

PET‐0.5  1970  0.17  0.3  58.7 

PET/PETG‐2.1/18  1960  0.2  0.3  55.92 

1. In the Module list located under the toolbar, click Property to enter 
the Property module.  

2. From the main menu bar, select Material→ Create to create a new 
material. The Edit Material dialog box appears. 

3. In the Edit Material dialog box, name the material PET. 
4. From the material editor menu bar, select Mechanical 

→Elasticity→ Elastic. ABAQUS displays the Elastic data form.  
5. In the appropriate fields in the Elastic data form, enter a value of 

1970 for Young's modulus and a value of 0.3 for Poisson's ratio. 
6. Click Ok to exit the material editor. 

Next, create a section definition that refers to the material PET. 

To define the section: 

7. From the main menu bar, select Section→ Create. The Create 
Section dialog box appears. In the Create Section dialog box: 

a. Name the section Section_1. 
b. In the Category list, accept Shell as the selection.  
c. In the Type list, accept Homogeneous as the default selection 

and click Continue. The section editor appears. 
8. In the editor: 

a.  Accept PET as the material selection. 
If you had defined other materials, you would click the arrow next to 
the Material text box to select the material of your choice. 

b. Accept the default value of 1 for the Plane stress/strain 
thickness, and click Ok.  

Assigning the section properties. You will use the Assign menu to assign 
the section Section_1 to the parts. To assign the section properties: 
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9. Click on the arrow next to the Part list located under the toolbar to 
see the list of available parts. Select the part half_1. The part half_1 
will be displayed in the viewport. 

10. From the main menu bar, select Assign→ Section. 
ABAQUS prompts you to select the regions to be assigned a 
section. 

11. Drag a rectangle around the part in the viewport to select the entire 
part. ABAQUS highlights all the regions of the part. 

12. Click mouse button 2 to indicate that you have finished selecting 
the regions to which the section will be assigned. The Assign 
Section dialog box appears consisting of a list of existing section 
definitions. Section_1 is selected by default since there are no other 
sections currently defined. 

13. In the Assign Section dialog box, accept the default selection of 
Section_1 and click Ok. ABAQUS assigns the section definition to 
the part. 

14. Repeat Steps 1 through 5 to assign the section to the part half_2. 

◇ Assembly 

Use the Assembly module to create instances of parts and position them 
relative to each other with respect to a common coordinate system. When 
you create a part instance, ABAQUS/CAE positions it so that the origin of 
the sketch that defined the base feature overlays the origin of the assembly's 
global coordinate system. In addition, the sketch plane is aligned with the 
X–Y plane of the global coordinate system. Note that even though a model 
may contain many parts, it contains only one assembly. 

To create part instances: 

1. Create an instance for part of half_1: 

a. In the Module list located under the toolbar, click Assembly to 
enter the Assembly module. 

b. From the main menu bar, select Instance→ Create. The Create 
Instance dialog box appears containing a list of all the parts in 
the current model. In the dialog box, select half_1 and click 
Apply. 

ABAQUS/CAE creates an instance of the half_1 and displays a 
graphic indicating the origin of the global coordinate system and the 
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orientation of the axes. ABAQUS/CAE names the instance half_1-1 
to indicate that it is the first instance of a part called half_1.  

2. Create an instance of the part half_2. 
a. Select half_2 from the Create Instance dialog box. 

ABAQUS/CAE displays a temporary image of the instance of 
the half_2. Because the origins of the original parts coincide, the 
new instance overlaps the existing instance of the half_1. 

b. Toggle on Auto-offset from other instances in the Create 
Instance dialog box, and click Apply. 

ABAQUS/CAE creates the new instance and applies an offset along 
the X-axis that separates the two instances. 

Positioning the instances: 

In addition to the simple translate and rotate procedures, the Assembly 
module provides a set of tools that allow users to position a selected part 
instance by defining the relationship between selected faces or edges. You 
can select a face (or an edge) of the instance that will be moved, called the 
movable part instance; select a face (or an edge) of the instance that 
remains fixed, called the fixed part instance; used two times Edge to Edge 
constraints to complete the positioning work. 

Save the model. 

◇ Step 

In this workshop we will use the Step and Interaction modules to continue 
defining the tearing specimen model. We will first define analysis steps and 
their corresponding output requests, including history, field, and monitor 
output. Next, define the necessary contact interactions between the half_1 
and half_2. Finally, define step-dependent boundary conditions and apply a 
load to the edge of half_1. 

Defining the analysis steps： 

The analysis of the specimen consists of two steps: an initial step and a 
general analysis step. In the initial step the boundary conditions that apply 
to various regions of the model are defined. Contact between regions of the 
model is also defined in the initial step. In the first general step contact 
between the various parts is established. To define the steps, do the 
following: 
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1. From the Module list located under the toolbar, select Step to enter 
the Step module; 

2. From the main menu bar select, Step→ Manager; 
The Step Manager appears. The initial step created by default is 
listed in this dialog box. 

3. From the lower-left corner of the Step Manager, click Create. 
The Create Step dialog box appears. In the dialog box you will 
name the step and set the analysis procedure for the step. 

4. Name the step step_1. The default procedure is set to Static, 
General. 

5. For the present analysis accept the default option of a Static, 
General procedure, and click Continue. The Step Editor appears. 

6. In the Description text field, enter load 
Click the Increment tab to enter the Increment tabbed page, and accept 
the default value of the initial increment size. The Increment tabbed 
page is used to set the controls for time increment in the analysis.  
 OK to create the step. The step_1step appears in the Step Manager. 

Click Dismiss to close the Step Manager. 
Applying boundary conditions to the assembly: 
To complete the definition of the model, it is necessary to define boundary 
conditions that will be applied in each step. In this problem there is an 
initial step (created by ABAQUS/CAE) and one analysis step. 
The initial step: The initial step allows you to define boundary conditions 
and interactions that are applicable at the very beginning of the analysis. 
For example, if a boundary condition or interaction is applied throughout 
the analysis, it is usually convenient to apply it in the initial step. 
Analysis steps: The initial step is followed by one or more analysis steps. 
Each analysis step is associated with a specific analysis procedure. There is 
no limit to the number of analysis steps you can define. 
In the Initial step the boundary conditions that one end was fixed and the 
other end displacement was given was defined. Also another boundary 
condition was defined on later end to restrain the displacement only in y-
direction. 

15. In the Module list located under the toolbar, click Load to enter the 
Load module. 
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16. From the main menu bar, select BC→ Manager. The Boundary 
Condition Manager appears. 

17. In the Boundary Condition Manager, click Create. The Create 
Boundary Condition dialog box appears. 

18. In the Create Boundary Condition dialog box: 
a. Name the boundary condition BC-1. 
b. Accept Initial in the Step text field. 
c. Accept Mechanical as the default Category selection and select 

Symmetry/Ant symmetry/Encastre as the Types for Selected Step 
selection. 

19. Click Continue. 
The Region Selection dialog box appears.  
Click mouse button 2 to indicate that you have finished selecting 
regions. The boundary condition editor appears. 

20. In the Edit Boundary Conditions dialog box: 
a. Toggle on Encastre (U1=U2=U3=UR1=UR2=UR3=0) to 

constrain fully the end at the bottom. 
b. Click Ok. 

The boundary condition that you just created appears in the 
Boundary Condition Manager, and arrows appear on the face 
indicating the constrained degrees of freedom. The Boundary 
Condition Manager shows that the boundary condition remains 
active in all steps of the analysis. 

To constrain the displacement at the other end: 
In the Boundary Condition Manager, click Create. 

The Create Boundary Condition dialog box appears. 
21. In the Create Boundary Condition dialog box: 

a. Name the boundary condition constrain displacement. 
b. Accept Initial in the Step text field. 
c. Accept Mechanical as the default Category selection, and select 

Displacement/Rotation as the Types for Selected Step selection. 
d. Click Continue. 

22. In the viewport, select the other end as the region where the 
boundary condition will be applied.  

23. Click mouse button 2 to indicate that you have finished selecting 
regions. The boundary condition editor appears. 
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The new boundary condition appears in the Boundary Condition Manager. 
24. Select File→ Save from the menu bar to save the model database 

file. 

◇  Mesh 

In this workshop I will mesh the part instances that you defined earlier. 
Creating a finite element mesh usually involves: 

1. In the model list located under the tool bar, select Mesh to enter the 
Mesh module. 

2. From the main menu bar, select Mesh→ Controls. Drag a square around 
the model to select the entire model. Click done to indicate that you 
have finished the selecting the regions to mesh. 

3. In the dialog box, accept Quad as the default Element Shape selection. 
4. Accept structured as the meshing technique that ABAQUS/CAE will 

use.  
5. Click Ok to assign the mesh controls and to close the dialog box. 
Selecting the ABAQUS element type 

6. From the main menu bar, select Mesh→ Element Type. ABAQUS/CAE 
displays the Element Type dialog box. 

7. In the dialog box, accept Standard as the Element Library selection. 
8. Accept Linear as the Geometric Order selection. Accept 3D Stress as 

the default Family of elements. 
9. In the Hex folder, select reduced integration as the Element Controls 

method if it is not already selected. A description of the default element 
type, C3D8R, appears at the bottom of the dialog box. ABAQUS/CAE 
will now associate C3D8R elements with the elements in the mesh. 

10. Click OK to assign the element type and to close the dialog box. 
11. From the main menu bar, select Seed→ Instance. 
12. From the main menu bar, select t seed→ Edge Biased, select the edge 

as the application region. Seeds appear on all the edges. Click done to 
exit the seeding utility. Meshing the assembly 

13. From the main menu bar, select Mesh→ Parts. Select the model and 
when it is highlighted, click mouse button 2 to indicate that your 
selection is complete. 
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14. The cursor changes to an hourglass while ABAQUS/CAE meshes the 
assembly.  

15. Click done after the meshing operation is complete. 

◇ Job 

Creating and submitting a job in ABAQUS/CAE: 
1. In the Module list located under the toolbar, select Job to enter the 

Job module. 
2. From the main menu bar, select Job→ Create to create the job.  

The Create Job dialog box appears. Name the job job_1, and click 
Continue. The job editor appears. 

3. Select Job→ Manager to start the Job Manager. 
From the buttons on the right edge of the Job Manager, click Submit 
to submit the job_1 job for analysis.  

When the job completes successfully, the text in the Status field of the Job 
Manager changes to Completed. It’s ready to view the results of the 
analysis with the Visualization module. From the buttons on the right side 
of the Job Manager, click Results. ABAQUS/CAE starts the Visualization 
module, opens the output database created by the job, and displays a plot of 
the model. 

◇  Visualization 

Visualization module allows viewing the results graphically using 
different methods. Here only reaction forces and corresponding 
displacement are needed. The reaction forces at nodes of the deforming 
edge were stored in rpt file, which were further used to analyze the 
simulation. 
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Appendix C-ABAQUS Input Files 

C.1Elastic Simulation 

*Heading 

** Job name: newbc_elastic Model name: Model-1 

*Preprint, echo=NO, model=NO, history=NO, contact=NO 

** 

** PARTS 

** 

*Part, name=half_1 

*Node 

      1,         -25.,           0.,         12.5 

      2,          -4.,           0.,         12.5 

      3,          -4.,           0.,           0. 

      4,         -25.,           0.,           0. 

      5,           0.,          -4.,         12.5 

      6,           0.,          -4.,           0. 

      7,           0.,         -25.,         12.5 

      8,           0.,         -25.,           0. 

      9,  -23.1827431,           0.,         12.5 

     10,  -21.5209446,           0.,         12.5 

     11,  -20.0013103,           0.,         12.5 

     12,  -18.6116753,           0.,         12.5 

     13,  -17.3409195,           0.,         12.5 

     14,  -16.1788712,           0.,         12.5 

     15,  -15.1162348,           0.,         12.5 

     16,  -14.1445026,           0.,         12.5 
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     17,  -13.2558994,           0.,         12.5 

     18,  -12.4433126,           0.,         12.5 

     19,  -11.7002411,           0.,         12.5 

     20,  -11.0207367,           0.,         12.5 

…Due to the huge number of nodes, parts of nodes are omitted here. 

1280, 1374, 1375,  181,  182 

1281, 1375, 1376,  180,  181 

1282, 1376, 1377,  179,  180 

1283, 1377, 1378,  178,  179 

1284, 1378, 1379,  177,  178 

1285, 1379, 1380,  176,  177 

1286, 1380, 1381,  175,  176 

1287, 1381, 1382,  174,  175 

1288, 1382, 1383,  173,  174 

1289, 1383, 1384,  172,  173 

1290, 1384, 1385,  171,  172 

1291, 1385, 1386,  170,  171 

1292, 1386,  169,    8,  170 

*Nset, nset=_PickedSet2, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet2, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet41, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet41, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet43, internal, generate 

    1,  1386,     1 
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*Elset, elset=_PickedSet43, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet44, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet44, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet46, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet46, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet47, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet47, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet48, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet48, internal, generate 

    1,  1292,     1 

*Elset, elset=_Surf-2_E1, internal, generate 

 443,  492,    1 

*Surface, type=ELEMENT, name=Surf-2 

_Surf-2_E1, E1 

** Section: shellsection_2 

*Shell Section, elset=_PickedSet48, material=PET, poisson=0.3, 
density=1350. 

0.0005, 5 

*End Part 

**   
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** 

** ASSEMBLY 

** 

*Assembly, name=Assembly 

**   

*Instance, name=half_1-1, part=half_1 

*End Instance 

**   

*Instance, name=half_2-1, part=half_2 

          0., 1.53075794227797e-15,        -12.5 

          0., 1.53075794227797e-15,       -12.5,           

 0.,   1.53075794227797e-15,        -13.5, 89.9999990194245 

*End Instance 

**   

*Nset, nset=Set-1, instance=half_1-1 

   7,   8, 180, 181, 182, 183, 184, 185, 186, 187, 188, 189, 190, 191 

*Nset, nset=Set-1, instance=half_2-1 

  1,  4,  5, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75 

 76, 77, 78 

*Elset, elset=Set-1, instance=half_1-1, generate 

  800,  1040,    20 

*Elset, elset=Set-1, instance=half_2-1, generate 

   1,  321,   20 

*Nset, nset=_PickedSet50, internal, instance=half_1-1 

   7,   8, 180, 181, 182, 183, 184, 185, 186, 187, 188, 189, 190, 191 

*Elset, elset=_PickedSet50, internal, instance=half_1-1, generate 

  800,  1040,    20 

*Nset, nset=_PickedSet57, internal, instance=half_2-1 
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  1, 4, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76, 77, 78 

*Elset, elset=_PickedSet57, internal, instance=half_2-1, generate 

   1,  321,   20 

*Elset, elset=_Surf-1_E1, internal, instance=half_2-1, generate 

 443,  492,    1 

*Surface, type=ELEMENT, name=Surf-1 

_Surf-1_E1, E1 

** Constraint: Constraint-1 

*Tie, name=Constraint-1, adjust=yes, no thickness 

half_2-1.Surf-2, half_1-1.Surf-1 

*End Assembly 

************************************************************ 

For mono-layer material PET-0.5 
************************************************************ 
**  

** MATERIALS 

**  

*Material, name=PET 

*Elastic 

1970., 0.3 

************************************************************
For bi-layer material PET/PETG-2.1/18 
************************************************************  

** MATERIALS 

**  

*Material, name=PET/PETG 

*Elastic 

1960., 0.3 
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************************************************************ 
** BOUNDARY CONDITIONS 

**  

** Name: BC-1 Type: Symmetry/Antisymmetry/Encastre 

*Boundary 

_PickedSet50, ENCASTRE 

** Name: BC-2 Type: Displacement/Rotation 

*Boundary 

_PickedSet57, 1, 1 

_PickedSet57, 2, 2 

_PickedSet57, 5, 5 

_PickedSet57, 6, 6 

** ---------------------------------------------------------------- 

**  

** STEP: Step-1 

**  

*Step, name=Step-1, inc=5000 

load 

*Static 

1e-06, 1., 1e-08, 1. 

**  

** BOUNDARY CONDITIONS 

**  

** Name: BC-2 Type: Displacement/Rotation 

*Boundary 

_PickedSet57, 2, 2, 2.5 

**  

** OUTPUT REQUESTS 
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**  

*Restart, write, frequency=0 

**  

** FIELD OUTPUT: F-Output-1 

**  

*Output, field 

*Node Output 

CF, RF, U 

*Element Output, directions=YES 

ELEDEN, ELEN, ENER, LE, PE, PEEQ, PEMAG, S 

**  

** HISTORY OUTPUT: H-Output-1 

**  

*Output, history, variable=PRESELECT 

*End Step 
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C.2Elastic-Plastic Simulation 

*Heading 

** Job name: newbc_plastic Model name: Model-1 

*Preprint, echo=NO, model=NO, history=NO, contact=NO 

** 

** PARTS 

** 

*Part, name=half_1 

*Node 

      1,         -25.,           0.,         12.5 

      2,          -4.,           0.,         12.5 

      3,          -4.,           0.,           0. 

      4,         -25.,           0.,           0. 

      5,           0.,          -4.,         12.5 

      6,           0.,          -4.,           0. 

      7,           0.,         -25.,         12.5 

      8,           0.,         -25.,           0. 

      9,  -23.1827431,           0.,         12.5 

     10,  -21.5209446,           0.,         12.5 

     11,  -20.0013103,           0.,         12.5 

     12,  -18.6116753,           0.,         12.5 

     13,  -17.3409195,           0.,         12.5 

     14,  -16.1788712,           0.,         12.5 

     15,  -15.1162348,           0.,         12.5 

     16,  -14.1445026,           0.,         12.5 

     17,  -13.2558994,           0.,         12.5 

     18,  -12.4433126,           0.,         12.5 
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     19,  -11.7002411,           0.,         12.5 

     20,  -11.0207367,           0.,         12.5 

…Due to the huge number of nodes, parts of nodes are omitted here. 

1280, 1374, 1375,  181,  182 

1281, 1375, 1376,  180,  181 

1282, 1376, 1377,  179,  180 

1283, 1377, 1378,  178,  179 

1284, 1378, 1379,  177,  178 

1285, 1379, 1380,  176,  177 

1286, 1380, 1381,  175,  176 

1287, 1381, 1382,  174,  175 

1288, 1382, 1383,  173,  174 

1289, 1383, 1384,  172,  173 

1290, 1384, 1385,  171,  172 

1291, 1385, 1386,  170,  171 

1292, 1386,  169,    8,  170 

*Nset, nset=_PickedSet2, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet2, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet41, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet41, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet43, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet43, internal, generate 

    1,  1292,     1 
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*Nset, nset=_PickedSet44, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet44, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet46, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet46, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet47, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet47, internal, generate 

    1,  1292,     1 

*Nset, nset=_PickedSet48, internal, generate 

    1,  1386,     1 

*Elset, elset=_PickedSet48, internal, generate 

    1,  1292,     1 

*Elset, elset=_Surf-2_E1, internal, generate 

 443,  492,    1 

*Surface, type=ELEMENT, name=Surf-2 

_Surf-2_E1, E1 

** Section: shellsection_2 

*Shell Section, elset=_PickedSet48, material=PET, poisson=0.3, 
density=1350. 

0.5, 5 

*End Part 

**   

** 

** ASSEMBLY 
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** 

*Assembly, name=Assembly 

**   

*Instance, name=half_1-1, part=half_1 

*End Instance 

**   

*Instance, name=half_2-1, part=half_2 

          0.,  1.53075794227797e-15,        -12.5 

          0.,  1.53075794227797e-15,        -12.5,            

0.,  1.53075794227797e-15,        -13.5, 89.9999990194245 

*End Instance 

**   

*Nset, nset=Set-1, instance=half_1-1 

   7,   8, 180, 181, 182, 183, 184, 185, 186, 187, 188, 189, 190, 191 

*Nset, nset=Set-1, instance=half_2-1 

  1,  4,  5, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75 

 76, 77, 78 

*Elset, elset=Set-1, instance=half_1-1, generate 

  800,  1040,    20 

*Elset, elset=Set-1, instance=half_2-1, generate 

   1,  321,   20 

*Nset, nset=_PickedSet50, internal, instance=half_1-1 

   7,   8, 180, 181, 182, 183, 184, 185, 186, 187, 188, 189, 190, 191 

*Elset, elset=_PickedSet50, internal, instance=half_1-1, generate 

  800,  1040,    20 

*Nset, nset=_PickedSet57, internal, instance=half_2-1 

  1,  4, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76, 77, 78 

*Elset, elset=_PickedSet57, internal, instance=half_2-1, generate 
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   1,  321,   20 

*Elset, elset=_Surf-1_E1, internal, instance=half_2-1, generate 

 443,  492,    1 

*Surface, type=ELEMENT, name=Surf-1 

_Surf-1_E1, E1 

** Constraint: Constraint-1 

*Tie, name=Constraint-1, adjust=yes, no thickness 

half_2-1.Surf-2, half_1-1.Surf-1 

*End Assembly 

************************************************************ 

For mono-layer material PET-0.5 
************************************************************ 
**  

** MATERIALS 

**  

*Material, name=PET 

*Elastic 

1970., 0.3 

*Plastic 

 58.7,   0. 

  59., 0.17 

************************************************************ 

For bi-layer material PET/PETG-2.1/18 
************************************************************ 
**  

** MATERIALS 

**  

*Material, name=PET/PETG 
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*Elastic 

1960., 0.3 

*Plastic 

   55.,  0. 

 55.92, 0.2 

************************************************************ 
** BOUNDARY CONDITIONS 

**  

** Name: BC-1 Type: Symmetry/Antisymmetry/Encastre 

*Boundary 

_PickedSet50, ENCASTRE 

** Name: BC-2 Type: Displacement/Rotation 

*Boundary 

_PickedSet57, 1, 1 

_PickedSet57, 2, 2 

_PickedSet57, 5, 5 

_PickedSet57, 6, 6 

** ---------------------------------------------------------------- 

**  

** STEP: Step-1 

**  

*Step, name=Step-1, inc=5000 

load 

*Static 

1e-06, 1., 1e-08, 1. 

**  

** BOUNDARY CONDITIONS 

**  
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** Name: BC-2 Type: Displacement/Rotation 

*Boundary 

_PickedSet57, 2, 2, 2.5 

**  

** OUTPUT REQUESTS 

**  

*Restart, write, frequency=0 

**  

** FIELD OUTPUT: F-Output-1 

**  

*Output, field, variable=PRESELECT 

**  

** HISTORY OUTPUT: H-Output-1 

**  

*Output, history, variable=PRESELECT 

*End Step 
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Appendix D-Simulation Results 

The stress components S11, S22 and S12 of the whole model are shown 
here in all the cases for both materials. In this case, the normal stress S33 is 
omitted because its value equals zero. 

Mono-layer material PET-0.5(Elastic) 
 
●     S11 
 
 

 
Figure D.1Normal stress S11 for mono-layer PET-0.5(Elastic) 
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●     S22 

 
Figure D.2Normal stress S22 for mono-layer PET-0.5(Elastic) 

●     S12 

 
Figure D.3Shear stress S12 for mono-layer PET-0.5(Elastic) 
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Mono-layer material PET-0.5(Elastic-Plastic) 
 
●     S11 
 

 

 
Figure D.4Normal stress S11 for mono-layer PET-0.5(Elastic-Plastic) 
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●     S22 

 
Figure D.5Normal stress S22 for mono-layer PET-0.5 (Elastic-Plastic) 

●     S12 

 
Figure D.6Shear stress S12 for mono-layer PET-0.5 (Elastic-Plastic) 
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Bi-layer material PET/PETG-21./18 (Elastic) 
 
●     S11 
 
 

 

Figure D.7Shear stress S11 for bi-layer PET/PETG (Elastic) 
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●     S22 

 

Figure D.8 Normal stress S22 for bi-layer PET/PETG (Elastic) 

●     S12 

 

Figure D.9 Shear stress S12 for bi-layer PET/PETG (Elastic) 
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Bi-layer material PET/PETG-21./18 (Elastic-Plastic) 
 
●     S11 
 
 

 

Figure D.10Normal stress S11for bi-layer PET/PETG (Elastic-Plastic) 
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●     S22 

 

Figure D.11 Normal stress S22 for bi-layer PET/PETG (Elastic-Plastic) 

●     S12 

 

Figure D.12 Shear stress S12 for bi-layer PET/PETG (Elastic-Plastic) 
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